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Dashboard Your Scorecard
Unleash the power of
Excel for visual data
analysis.
by Mark W. Lehman, CPA,
Carol M. Lehman and
Jim Feazell

D

ashboard reports created in Microsoft Excel are powerful, flexible and easy to design. In much the same way that an automobile dashboard graphically displays numerous measures of
performance from the gas level to oil pressure, a computer dashboard
presents critical data in a variety of visual formats. From this organized visual display, optimal business decisions can be made quickly and
efficiently.
Most enterprise systems provide dashboards that decision makers can easily customize to fit their specific needs. But suppose the data you need to analyze is
regularly downloaded from your enterprise
system and Microsoft Excel is the only available data analysis tool. If you are reasonably
proficient at using charts, PivotTables and

conditional formatting, this article will show
you how you can design your own dashboard with minimal time and effort. Adding
a combo box control will further unleash
the power of Excel to customize the information displayed in graphics.
Imagine the possibilities for using dashboards to quickly analyze data in a variety

Editor’s note: The Excel worksheet used to create the sample dashboard presented
here, along with completed dashboards in Excel 2007 and 2010, are available with
the online version of this article. Go to journalofaccountancy.com and enter
20092427 in the search box to find the article.
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of ways and to communicate meaningful
information to specific target audiences.
Imagine the effectiveness of your explanations of companywide financial or operational trends when, in the same window, you can instantly respond to a
question about trends for a division, location, product line or employee.
You can learn to perform these data
analyses with Excel as we guide you

you to analyze sales trends, the dashboard
will prove useful in management’s monthly performance assessment meeting.
The charts provide three views of total
unit sales: percentage of sales by representative (pie chart), unit sales by representative and customer category (stacked
bar), and unit sales by brick style for a
selected sales representative (column
chart). The table shows a year-to-date

through the dashboard shown in Exhibit
1. Excel 2010 commands and illustrations
are included in the article. Any differences
in Excel 2007 commands are noted.

THE SAMPLE DASHBOARD
For illustration purposes, suppose your
company has implemented a balanced
scorecard with the goal of increasing sales
of its line of brick. In addition to enabling

Exhibit 1

Sample Excel Dashboard in Excel 2010

Exhibit 2

Data Structure of Downloaded Data File
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analysis of unit and dollar sales for each
sales representative. To the right of the
table are Sparklines, one-cell charts available in Excel 2010.

SELECTING SCORECARD
MEASURES
Suppose one measure of your success is
the extent that each sales representative
sells the entire product line, not just a few
select brick styles, to all three categories of
your customers—commercial, government
and residential. To monitor this performance measure, you regularly download

Exhibit 3

sales data from your enterprise system as
shown in Exhibit 2.
If you are familiar with the PivotChart
feature, you are aware that only a single
chart can be created from a PivotTable.
While you can alter the data and chart type
to view a revised chart, you can view only
one chart at a time. However, using the
GETPIVOTDATA function, you can view
multiple charts of the same PivotTable
data. All the tables and charts in Exhibit
1 were created with GETPIVOTDATA
functions that extracted data from just two
PivotTables. Using a combo box, you can

drill down into the data to instantly display a custom chart showing performance
measures for selected items, such as by
representative, in this case.
Understanding the value of dashboards
created in Excel, let’s create the dashboard
for our illustrative company and see how
this in-depth analysis is performed.

PREPARING YOUR DATA
When working with data tables, you
should anticipate that the size of the data
table will change. For example, as our illustrative company earns additional sales,

PivotTable on PivotOne Worksheet
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the data table will extend beyond its current 140 rows. By formatting the data as
a table, Excel will extend the data table
range automatically to include the new
data. Using a table with other Excel tools,
such as PivotTables and charts, ensures
that these objects reflect all data.
To begin, download the file JofA Dashboard.xlsx from the online version of this
article on journalofaccountancy.com
and save it to your computer. Go to the
Data worksheet and position the cell
pointer on any cell in the table. Press Ctrl
A to select all the data in the table. From
the Home tab and the Styles group, select
Format as Table. Select a table style and
click OK to accept the format.

CREATE A PIVOTTABLE
Your next step is to create a PivotTable on
a new worksheet. Position your cell pointer on any cell in the table on the Data
worksheet. From the Insert tab and Tables group, select PivotTable. Click OK
to accept the default options to place the
PivotTable on a new worksheet. The new
worksheet displays a placeholder for the
PivotTable and the PivotTable Field List
dialog box. In the PivotTable Field List,
drag the Style field to the Column Labels
box, Representative to the Row Labels
box, Category to the Row Labels box
under Representative, and Quantity to
the Values box. The PivotTable (Exhibit 3)
shows the total quantity (in thousands) of
each brick style sold by each representative by customer category. Rename the
worksheet PivotOne.
The GETPIVOTDATA function is used
to retrieve data from a PivotTable. Unlike
a VLOOKUP function that retrieves data
from a table based on a single value, a
GETPIVOTDATA function can retrieve
data using one, two or all three of the fields
selected in the rows and columns of this
PivotTable.

Exhibit 4

Data Series for Pie Chart

pointer on cell B4. Enter an equal sign to
begin a function and point to the cell in the
PivotTable containing Allen Pearson’s total
sales, 942 (cell H5 on the PivotOne worksheet in Exhibit 3). Excel creates the GETPIVOTDATA function automatically:
=GETPIVOTDATA("Quantity",Pivot
One!$A$3,"Representative","Allen
Pearson")
Press Enter to complete the function.
To prepare this function to be copied down
the column, edit the function to replace
"Allen Pearson" (including the quotation
marks) with A4, the cell reference to Allen
Pearson. The reference to A4 ensures each
copied function uses the adjacent sales
representative. After copying the function,
your worksheet appears as shown in Exhibit 4.
The arguments of the function in B4
(Exhibit 4) instruct Excel to:
"Quantity"

Retrieve a Quantity from
the PivotTable …

PivotOne!$A$3 Located on the PivotOne
worksheet (Exhibit 3)
beginning at cell A3...
"Representative" And search the Representative field of the
PivotTable…

CREATING THE PIE CHART

A4

Let’s begin by preparing the data series for
the pie chart. On the Preparation worksheet
(shown in Exhibit 4), we have listed the sales
representatives at A4:A8. Position your cell

The Excel Trace Precedents tool (Formulas tab, Formula Auditing group)
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For Allen Pearson, the
representative in cell A4.

illustrates the function’s dependence on
the contents of A4 and the PivotTable (Exhibit 3). Highlight cells A4:B8 and insert
a pie chart. Cut the pie chart and paste it
in the upper-left corner of the Dashboard
worksheet. Resize the chart to fit adjacent
to the existing table.

DOUBLE YOUR ANALYSIS
The stacked bar chart in the lower-left corner of the dashboard (Exhibit 1) displays
data based on two fields—representative
and category. On the Preparation worksheet, note the list of representative names
in A12:A16 and the customer categories
in B11:D11. Position your cell pointer at
B12 of the Preparation worksheet. Enter
an equal sign to begin a function and point
to the cell in the PivotTable containing
Allen Pearson’s total sales to Commercial
customers, 326 (cell H6 on the PivotOne
worksheet in Exhibit 3)). Excel creates the
GETPIVOTDATA function:
=GETPIVOTDATA("Quantity",Pivot
One!$A$3,"Representative","Allen
Pearson", "Category","Commercial")
Press Enter to complete the function.
To prepare this function to be copied, edit
the function to replace "Allen Pearson"
with $A12, the cell reference to Allen
Pearson, and replace "Commercial" with
B$11, the cell reference to Commercial.
After copying the function to B12:D16,
your schedule appears as shown in Exhibit 5.
Exhibit 5 shows one of the copied functions. Notice that the first two arguments
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Exhibit 5

Data Series for Stacked Bar Chart

Exhibit 6

Data Series for Column Chart

of the function, "Quantity",PivotOne!
$A$3, are identical to the function used
to create the functions for the pie chart.
Both charts retrieve data from the same
PivotTable. The remainder of the function
in C14 instructs Excel to search the Representative field of the PivotTable (Exhibit
3) for Mark Stevens, the representative in
A14, and to retrieve the quantity for the
Category in C11, Government.
Highlight A11:D16 and insert a
Stacked Bar chart. Cut the chart and paste
the chart in the lower-left corner of the
Dashboard worksheet.

A DIFFERENT PERSPECTIVE
To provide insight into certain performance
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measures, you may need to drill down into
data for more detailed analysis. For example, what style of brick has Janet Sellers sold
to her customers? What style has Scott Edwards not sold well? In the column chart
in the lower-right corner of the dashboard
(Exhibit 1), notice the combo box that allows you to conveniently view data for a selected item, such as a specific representative. Although the combo box appears to be
part of the chart, it’s actually an independent object positioned over the chart. Three
Excel features—a combo box, an INDEX
function, and the GETPIVOTDATA function—work together to create a custom
chart for any representative.
To assist you in creating the column

chart, we have entered on the Preparation
worksheet a list of styles in A23:A28 and
a list of representatives in D24:D28. Let’s
begin by creating the GETPIVOTDATA
functions. For the moment, you will retrieve the sales for Janet Sellers, the representative name entered in B20. Enter an
equal sign in B23 to begin a function and
point to the cell in the PivotTable containing Janet Sellers’ total sales of New
England, 272 (cell B9 on the PivotOne
worksheet in Exhibit 3). Excel creates the
GETPIVOTDATA function:
=GETPIVOTDATA("Quantity",Pivot
One!$A$3,"Representative","JanetSellers
","Style","New England")
Press Enter to complete the function.
Edit the function to replace "Janet Sellers"
with $B$20, the cell reference to Janet
Sellers, and replace "New England" with
A23, the cell reference to New England.
After copying the function to B24:B28,
your worksheet appears as shown in Exhibit 6.
Exhibit 6 shows one of the copied functions. The function at B24 retrieves the
Quantity from the PivotTable at A3 of the
PivotOne worksheet for Representative
Janet Sellers (B20) of brick Style Red Classic (A24). The precedent arrows in Exhibit
6 illustrate the function’s dependence on
cells B20, A24, and the PivotTable.
A combo box and the INDEX function
eliminate the need to input a different representative in B20 to drill down into the
PivotTable to display the desired data in
the chart. To create a combo box, you must
add the Developer tab to the Excel Ribbon if it is not already present. To do so,
from the File tab, select Options and Customize Ribbon. In the right window, select the Developer option box. (In Excel
2007: Select the Office button and the
Excel Options button. From the left pane,
click Popular and check the option box
Show Developer tab in the Ribbon option
box.) After clicking OK, a Developer tab
appears in the Ribbon to the right of the
View tab.
On the Developer tab, select Insert
from the Controls group. In the Form
Controls panel, select Combo Box. Move
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your pointer adjacent to the representative
list, and click and drag to create a box
about two cells in width. A blank combo
will appear. Right-click the combo box and
select Format Control from the menu list.
Enter Preparation!$D$24:$D$28 in the
Input range box (Exhibit 7) to identify the
range of cells containing the items to display in the combo box. Enter Preparation!
$B$19 in the Cell link box to identify
when Excel is to store the selected item.
The worksheet reference, Preparation!, is
required for the combo box to work when
pasted in another worksheet.
Click OK and click any cell to unselect
the combo box. Let’s experiment with the
combo box. Use it to select one of the sales
representatives. You may be disappointed
that the sales representative’s name does
not appear in B19. Instead, a number appears indicating the position of the sales
representative in the list. When you select
an item, the combo box enters that selection’s numeric order in the input range
(D24:D28) in the cell link (B19).
Now, let’s tackle the final piece of the
puzzle. Enter the function =INDEX
(D24:D28,B19) in cell B20 (Exhibit 8).
The function =INDEX(D24:D28,B19)
in B20 directs Excel to:
D24:D28 Select from the list of representatives at D24:D28…
B19

the name Janet Sellers in
row 2 of the list.

The three Excel features are now in
place. When you select Janet Sellers from
the combo box, the number 2 is stored in
B19. Create a column chart using the schedule in A23:B28 and position the chart in the
lower-right corner of the Dashboard worksheet. Right click on the combo box, and
then cut and paste the combo box to any
blank cell on the Dashboard worksheet (do
not paste the combo box into the chart).
Right-click on the combo box again to drag
the object over the chart. Click any cell to
deselect the combo box.

BEYOND CHARTS
While graphics are ideal for depicting
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Exhibit 7

Format Control for Combo Box

Exhibit 8

INDEX Function Selects From List

numeric data, you may need to view some
numeric data in a table. For example, our
dashboard includes a simple year-to-date
analysis of sales by representative. The structure of the schedule appears on the Dashboard worksheet. The prior-year amounts
are entered, and the current-year amounts
will be retrieved from the PivotTable. At cell
I5 on the Dashboard worksheet, enter an
equal sign and point to the cell on the
PivotOne worksheet containing Allen
Pearson’s total sales, 942, in cell H5.
Change the function reference to "Allen
Pearson" to G5. The schedule has been
formatted using the Format as Table tool
and, therefore, the function is automatically copied down the schedule.
Conditional formatting enables you to
apply the power of graphics within a table
(see “Discover the Power of Excel 2007,”
JofA, Feb. 2008, page 60). Select cells J5:J9.

Then, from the Home tab in the Styles
group, select Conditional Formatting,
Icon Sets, and the 5 Arrows (Colored)
option to visually depict the relative period-over-period performance of sales representatives. If you later want to change the
icon set or otherwise alter the rules for displaying them (such as to select green icons
when lower numbers are better, as in the
case of customer complaints), highlight the
cells and from the Styles group on the
Home tab, select Conditional Formatting
and Manage Rules. Click on the icon set
and click on Edit Rule. Make the appropriate changes in the dialog box and click
OK twice.

SPARKLINES
Sparklines, a new feature of Excel 2010,
are one-cell charts useful in representing
trending data (see “What’s New for CPAs
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in Office 2010,” JofA, Feb. 2010, page 40).
In our dashboard in Exhibit 1, Sparklines
show the monthly trend for total dollar sales
for each sales representative.
Because the PivotTable in the PivotOne
worksheet does not contain either sales by
month or total dollar sales, you must create a second PivotTable. Using the table in
the Data worksheet, insert a PivotTable on
a new worksheet with Representative as
the row labels, Date as the column labels,
and Total Sale as the values. Right-click
on any date in row 4 of the new worksheet
and select Group. Be certain that Months
is selected and click OK. Rename your
worksheet PivotTwo.
Position your cell pointer on L5 of the
Dashboard worksheet. From the Insert
tab in the Sparklines group, select Line.
For the Data Range, highlight B5:F9 on the
PivotTwo worksheet. For the Location
Range, highlight L5:L9 on the Dashboard
worksheet, and click OK. With the Sparklines highlighted, select the Sparkline Tools
and Design tabs to view available options,
such as the High Point and Low Point options in the Show group.

UPDATING YOUR DASHBOARD
Having formatted the data table using the
Format as Table tool, new data entered
or copied to your table are automatically
included in the range of cells used in the
PivotTables. However, you must refresh
your PivotTables (right-click inside the
PivotTable and select Refresh) to ensure
that any new data are reflected in your
charts and tables.
Any new columns or rows added to
the PivotTables (for example, a new sales
representative or brick style appears in
the data) will require minor modifications
of your schedules on the Preparation
worksheet. Simply add the new row or
column label to the schedule, copy your
existing GETPIVOTDATA functions, and
revise the data series used in the related
chart.
Any new data added to a PivotTable created for the Sparklines will require you to
update the data range for these charts (rightclick on any Sparkline and select Edit Data
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on the Sparkline Tools Design tab).
These important but simple maintenance
steps are well worth the effort to ensure your
dashboard is current and accurate.

USE YOUR IMAGINATION
In our dashboard example, the column
chart (lower right) shows the sales by brick
style for a selected sales representative. The
words by and for in that statement are key
to comprehending the immense value of
a dashboard. These words emphasize that
a PivotTable can be used to analyze the
data by one or more fields. Adding a
combo box makes it easy to select the data
for a selected item, such as a division, employee, or product line. Note the use of by
and for in these examples:
■ A bank employee analyzes the average loan interest rates by customer income category for a selected branch
office.
■ A store manager analyzes sales returns by time of day for a selected
sales clerk.
■ An auditor analyzes a client’s inventory adjustments by store and by
product line for all inventory control
clerks.
Now that the mystery behind creating
powerful dashboards with Excel has been
revealed, you can begin to identify potential dashboard applications for your own
data. A wealth of resources is available on
the Internet to further your understanding
of this powerful data visualization tool. ❖
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